Faculty & Staff

Outlook 2016 for Mac: Basics

Quick Reference Guide
### REVISION CONTROL

<table>
<thead>
<tr>
<th>Document Title:</th>
<th>O2016 Outlook Mac Basics – Staff - QRG.docx</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author:</td>
<td>Campus Training</td>
</tr>
<tr>
<td>File Reference:</td>
<td></td>
</tr>
</tbody>
</table>

#### Revision History

<table>
<thead>
<tr>
<th>Revision Date</th>
<th>Revised By</th>
<th>Summary of Revisions</th>
<th>Section(s) Revised</th>
</tr>
</thead>
<tbody>
<tr>
<td>9/18/2015</td>
<td>T. Sherman</td>
<td>Created document</td>
<td>Click here to enter Revision Date</td>
</tr>
</tbody>
</table>

#### Review / Approval History

<table>
<thead>
<tr>
<th>Review Date</th>
<th>Reviewed By</th>
<th>Action (Reviewed, Recommended or Approved)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
# Table of Contents

1.0 Introduction ................................................................................................................. 5

2.0 Getting Started ............................................................................................................. 5
   2.1 Configuring Outlook ................................................................................................. 5
   2.2 Accessing Outlook ................................................................................................. 6

3.0 Outlook Overview ....................................................................................................... 7
   3.1 Ribbon .................................................................................................................... 7
   3.2 Quick Access Toolbar ........................................................................................... 7
   3.3 Folder Pane ........................................................................................................... 7
   3.4 Navigation Bar ...................................................................................................... 8
   3.5 Status Bar ............................................................................................................. 8

4.0 Mail ............................................................................................................................ 8
   4.1 Creating and Sending Email .................................................................................. 8
   4.2 Attaching files ...................................................................................................... 9
   4.3 Receiving and Reading Messages ......................................................................... 9
   4.4 Responding to messages ..................................................................................... 10
      4.4.1 Replying to Messages ................................................................................... 11
      4.4.2 Forwarding Messages .................................................................................. 11
   4.5 Working with attachments ................................................................................... 12
   4.6 Deleting Messages ............................................................................................... 12
   4.7 Restoring Deleted Messages ............................................................................... 13
   4.8 Emptying Deleted Items Folder .......................................................................... 14
   4.9 Printing Messages ............................................................................................... 14
   4.10 Creating Signatures ............................................................................................ 15
      4.10.1 Creating Signatures for New Messages ...................................................... 15
      4.10.2 Creating Signatures for Replies and Forwards ........................................ 16
   4.11 Setting up Automatic Replies ........................................................................... 17
   4.12 Turning off Automatic Replies .......................................................................... 18

5.0 Calendar .................................................................................................................... 18
   5.1 Viewing your Calendar ....................................................................................... 19
   5.2 Scheduling appointments ..................................................................................... 20
      5.2.1 Scheduling an Individual Appointment ..................................................... 20
      5.2.2 Scheduling a Recurring Appointment ....................................................... 21
5.3 Updating Appointments ................................................................. 22
5.4 Deleting Appointments ............................................................... 22
5.5 Sharing your calendar ................................................................. 23
5.6 Printing your calendar ............................................................... 24
5.7 Scheduling Meetings ................................................................. 25
  5.7.1 Scheduling Individual Meetings ........................................... 25
  5.7.2 Scheduling Recurring Meetings ......................................... 26
5.8 Updating Meetings .................................................................. 27
5.9 Canceling Meetings ................................................................. 28
5.10 Responding to Meeting Requests ........................................... 29
  5.10.1 Accepting A Meeting Request ........................................... 29
  5.10.2 Tentatively Accepting a Meeting Request ......................... 30
  5.10.3 Declining a Meeting Request ......................................... 31
  5.10.4 Proposing a New Times .................................................. 32
6.0 Email Related Policies ............................................................... 33
7.0 Getting Help ........................................................................... 33
1.0 Introduction

Microsoft Outlook is the official email system for CSUB. Outlook allows you to send and receive messages, schedule appointments, manage tasks, work with your address book, and organize your mailbox. With Outlook, you can access Outlook from most devices, using the desktop, mobile, or web apps.

This guide is designed for use with the Outlook desktop app. It will assist you with performing basic tasks using the Outlook features.

2.0 Getting Started

Getting started with Outlook is a process. The process begins with you setting up your account on Office 365. Next, you will need to setup and configure Outlook to access your Office 365 account.

2.1 Configuring Outlook

In this step, you will setup and configure Outlook to access your Office 365 account.

1. Use the App Launch pad to,
   • Locate the Outlook icon and
   • Click the Outlook icon

2. From the Outlook menu, click Tools

3. On the Tools tab, click Accounts

4. On the Accounts page, click Exchange or Office 365

5. On the configuration page,
   • Enter your Email address
   • Leave the default for Method
   • Enter email address for the user name
   • Enter your password
   • Click Add Account
6. If you receive a similar message,
   - Click **Always use my response for this server**
   - Click **Allow**

7. Outlook opens.

### 2.2 Accessing Outlook

These instructions will guide you in accessing Outlook from your personal computer or laptop.

1. Click the Outlook icon from your launch pad

2. Outlook opens.
3.0 Outlook Overview

Outlook has several modules to assist you with communicating with others, scheduling appointments, and many other activities. The modules include Mail, Calendar, People, Tasks, Notes, and Folders. This list below describes briefly the functions of these tools.

- **Mail**
  - Send and receive messages.

- **Calendar**
  - Schedule appointments and meetings.

- **People**
  - Maintain your contacts or your address book.

- **Tasks**
  - Create To Do list with due dates and more information.

- **Notes**
  - Create notes or lists of information.

3.1 Ribbon

The Ribbon contains context sensitive functions for each Outlook module or tool. Groups are used to organize related functions.

3.2 Quick Access Toolbar

The Quick Access Toolbar is a customizable menu. You can select your most commonly used functions and add them to this toolbar. Once added to the toolbar, you can quickly access these functions.

3.3 Folder Pane

The Folder Pane is located on the left-hand side of the screen. From this pane, you can view your Inbox, access your Sent Items, or empty your trashcan.
3.4 Navigation Bar

The Navigation Bar is located at the bottom. From the Navigation Bar, you can move between the Outlook modules, such as the Calendar and Tasks.

3.5 Status Bar

The Status Bar provides information and additional capabilities depending on the module you are using.

- Status Message
  In the Mail module, the Status Bar displays information about your messages. For example, the Status Message can show the number of mail items in your inbox. In this case, there are 18 mail items of which two are unread.

4.0 Mail

This section covers the Mail module. From the Mail module, you can send and receive, work with, and manage your emails. By default, Outlook opens to the Mail module. However, you can access the Mail module by clicking Mail on the Navigation Bar.

4.1 Creating and Sending Email

These instructions will assist you with creating and sending an email.

1. From the Home tab, click New Email

2. When the new email opens,
   - In the To field, type the person’s name or email address.
   - (Optional) In the Cc.. field, type the person’s name or email address that you would like to carbon copy.
   - (Optional) In the Bcc.. field, type the person’s name or email address that you would like to blind carbon copy.

   You can click the button to search for their email address.
3. To complete the message,
   - In the **Subject**, type the subject of your email.
   - In the body, type your email message.

4. When satisfied, click the Send button.

### 4.2 Attaching files

You can easily attach documents to your email. You can either drag and drop the file to the body of your message or use the Attach File button. These instructions will guide you in attaching a file using the Attach File button.

1. From the **Message** tab, click **Attach File**

2. On the next screen,
   - Navigate to the desired file
   - Select the file
   - Click **Choose**

3. Once the file is attached, you can attach more files, if desired.

4. When satisfied, click the **Send** button.

### 4.3 Receiving and Reading Messages

When you receive messages, they will appear in your **Inbox**. From your **Inbox**, you can read and preview your messages. These instructions will guide in receiving and reading your emails.

1. Your messages will appear in your **Inbox**
2. There are two methods for reading your emails.

   Method 1
   - You can select it and
   - Read it from the preview pane

3. Method 2
   - You can double-click the email and it will open in a different window

4.4 Responding to messages

   You can respond to your emails from your inbox by opening the email or from the preview pane. Your options for responding to messages include replying, replying to all, and forwarding. These instructions will guide you in responding from an open email.

   - Reply
     Your response is sent to sender

   - Reply All
     Your response is sent to everyone addressed on the email

   - Forward
     Your response is sent to the person you select.
4.4.1 Replying to Messages

These instructions will guide you in replying to messages.

1. From your Inbox, open the email you want to reply to.

2. On the Message tab, click **Reply** or **Reply All**

3. When the new email opens,
   - Type your reply in the space above the original message
   - Click **Send**

---

4.4.2 Forwarding Messages

These instructions will guide you in forwarding messages.

1. From your Inbox, open the email you want to forward.

2. Click **Forward**

3. When the new email opens,
   - In the **To**, enter the recipient's name or email address
   - Type your reply in the space above the original message
   - Click **Send**
### 4.5 Working with attachments

When you receive an attachment, you can preview, open, quick print, save, copy, or remove it. These instructions will guide in working with attachments.

<table>
<thead>
<tr>
<th>Step</th>
<th>Instruction</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.</td>
<td>When an email contains an attachment, you will see a paperclip icon. Double-click the email to open it.</td>
</tr>
<tr>
<td>5.</td>
<td>Double-click the attachment to open it.</td>
</tr>
<tr>
<td>6.</td>
<td>The attachment opens in a new window.</td>
</tr>
</tbody>
</table>
| 7.   | For additional options,  
  - Right-click the attachment  
  - Select an option from the pop-up menu  
  - Follow the screen directions, if applicable. |

### 4.6 Deleting Messages

You can delete an email message from your Inbox or while the email is open. These instructions guide you deleting an email from your Inbox.

<table>
<thead>
<tr>
<th>Step</th>
<th>Instruction</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>From your Inbox, select the email you would like to delete.</td>
</tr>
<tr>
<td>2.</td>
<td>On the Message tab, click <strong>Delete</strong></td>
</tr>
</tbody>
</table>
3. The message disappears from your Inbox.

   When you delete an email message, the message is moved to your Deleted Items folder. If you inadvertently delete an email message, you can retrieve it from this folder, provided you have not emptied the folder.

4.7 Restoring Deleted Messages

When you delete an email message, the message is moved to your Deleted Items folder. If you inadvertently delete an email message, you can retrieve it from this folder, provided you have not emptied the folder. These instructions will assist you in restoring a deleted email message.

1. From the folder pane, click the Deleted Items folder in the Folder Pane.

2. From the Deleted Items folder, right-click the email message

3. From the menu,
   - Click Move
   - Click Choose Folder...

4. On the next window,
   - In the search box, begin typing the name of the folder, such as Inbox
   - From the results, click Inbox
   - Click Move

5. Your email message is moved back to your Inbox.
4.8 Emptying Deleted Items Folder

When you delete messages, they are moved to your Deleted Items Folder. They remain in the folder until it is emptied. These instructions will guide you in emptying your Deleted Items folder.

1. To begin, right-click Deleted Items

2. From the pop-up menu, click Empty Folder. Once the items are deleted, they cannot be recovered.

4.9 Printing Messages

On occasion, you may want to print an email message. The common method is using the File menu from an open email message. These instructions will walk through this process.

1. From your Inbox, open the email you want to print

2. From the Quick Access Toolbar, click the Print icon

3. On the Print screen,
   - Make your selections
   - Click Print
4.10 Creating Signatures

An email signature is the block of text that is added to the end of your email message. Typically, it contains your contact information, such as name, title, department, business address, phone number, fax number, and email address. You can have signatures for new messages and for replies and forwards.

4.10.1 Creating Signatures for New Messages

When creating signatures for new messages, you can specify whether your signature applies to new messages, to replies and forwards, or to both. These instructions will guide you in creating a signature for new messages.

1. To begin, click the New Email button.

2. On the Message tab, click Signature.

3. Click Edit Signatures…

4. In the Signature name, click +

5. Double-click Untitled

6. Type a name for the signature, such as New Messages

7. In the Signature box, type your signature text

8. From the Choose default signature, In the New messages, click the down arrow and select your signature (i.e. New Messages)
9. The next time you compose an email, your new signature will appear.

### 4.10.2 Creating Signatures for Replies and Forwards

You can have different signatures for your new messages and for replies and forwards. You can specify which signature to use when. These instructions will guide you in creating a signature for replies and forwards.

1. To begin, click the **New Email**

2. On the Message tab, click **Signature**

3. Click **Edit Signatures...**

4. In the **Signature name**, click +

5. Double-click **Untitled**

6. Type a name for the signature, such as **Replies and Forwards**

7. In the **Signature** box, type your signature text

   ```
   John Adams
   ```
8. From the Choose default signature,
   - In the Replies/forwards, click the down arrow and select your signature (i.e. Replies and Forwards)
   - Close the window

9. The next time you reply to or forward an email, your new signature will appear.

4.11 Setting up Automatic Replies

You can set up automatic email replies, such as when you are away on vacation or business. The process involves creating a template and a rule. These instructions cover the steps involved.

1. Click the Tools tab

2. On the Tools tab, click Out of Office

3. On the Autoreply Settings page,
   - Click Send automatic replies for account
   - In the Reply once to each sender with, type your autoreply text

4. Check only Only Send replies during this time period
   - Select the start date and time
   - Select the end date and time
5. (Optional) If you want to reply automatically to email from people outside of CSUB, then
   - Check **Also send replies to senders outside my organization**
   - Check **Send to all external senders**
   - In the **Reply once to each external sender with**, enter your autoreply text
   - Click OK

### 4.12 Turning off Automatic Replies

These instructions cover turning off automatic replies.

1. Click the **Tools** tab

2. On the Tools tab, click **Out of Office**

3. On the Autoreply Settings page, uncheck **Send automatic replies for account**

4. Click **OK**

### 5.0 Calendar

This section covers the Calendar module. From the Calendar module, you can create and manage your appointments. You can view your calendar in daily, weekly, and monthly formats. Additionally, you can create meetings and invite people to attend. The integration between the Calendar and Mail modules allow you to send and forward appointments and to mail your calendar to others.

To access the Calendar module, click Calendar on the navigation bar (bottom of screen)
5.1 Viewing your Calendar

You can display your calendar in a number of ways. You can display it as a daily, weekly, or monthly view. Additionally, you view it based on the work week or as schedule. To change your calendar view, click the desired icon the Home tab.

The table below shows the available calendar views.

<table>
<thead>
<tr>
<th>Calendar Views</th>
<th>Illustration</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Day</strong></td>
<td></td>
</tr>
<tr>
<td>• Displays your appointments by time for the selected day</td>
<td>![Day Illustration]</td>
</tr>
<tr>
<td><strong>Work Week</strong></td>
<td></td>
</tr>
<tr>
<td>• Displays your appointments by day and time for your work week, such as Monday through Friday</td>
<td>![Work Week Illustration]</td>
</tr>
<tr>
<td><strong>Week</strong></td>
<td></td>
</tr>
<tr>
<td>• Displays your appointments by day and time for the week (Sunday through Saturday)</td>
<td>![Week Illustration]</td>
</tr>
</tbody>
</table>
Month

- Default view
- Displays your appointments for the month including weekends

5.2 Scheduling appointments

The Calendar module allows you to schedule individual and recurring appointments. You can specify the subject, location, duration, appointment information. Additionally, you choose how the appointment will appear on your calendar and when to be reminded about your appointments.

5.2.1 Scheduling an Individual Appointment

An individual appointment creates a single entry on your calendar for an event, such as a meeting, conference, etc. These instructions will help you with creating an individual appointment.

1. From the Calendar Home tab, click Appointment

2. On the Appointment tab,
   - In the Subject field, type subject of your appointment
   - Click the Rooms button

3. On the Search page,
   - Enter your search criteria
   - Select the directory
   - Select the room from the results
   - Click Required

4. In the Starts,
   - Use the calendar picker to select a date
   - Use the down arrow to select a time

5. In the Ends,
   - Use the calendar picker to select a date
   - Use the down arrow to select a duration
6. In the body, type the appointment information, such as purpose and the agenda.

7. When satisfied, click the Save & Close button.

5.2.2 Scheduling a Recurring Appointment

A recurring appointment creates multiple entries on your calendar for a single event, such as monthly department meetings, vacation, etc. These instructions will help you with creating a recurring appointment.

1. From the Calendar Home tab, click New Appointment

2. In the Subject field, type subject of your appointment

3. In the Location field, type the location for your appointment

4. In the Start time,
   - Use the calendar picker to select a date
   - Enter a time

5. In the End time,
   - Use the calendar picker to select a date
   - Use the down arrow to select a duration

6. In the body, type the appointment information, such as purpose and the agenda.

7. On the Appointment tab, click Recurrence.
8. On the **Appointment Recurrence**, make your selection, such as *Every Monday*, or click Custom to specify a recurrence pattern

9. When satisfied, click the **Save & Close** button.

### 5.3 Updating Appointments

You can quickly update your appointments from your calendar or by opening your appointments. These instructions will guide you in opening your appointments for updating.

1. From your Calendar, double-click the appointment you would like to update.

2. When the appointment opens, make the desired changes.

   *If you open a recurring appointment, you can update the one appointment occurrence or update the entire series. To update the series, click **Go To Series***

3. When satisfied, click the **Save & Close** button to save your changes.

### 5.4 Deleting Appointments

From your calendar, you can delete appointments quickly. These instructions will assist you in an appointment from your calendar.
1. From your Calendar, open the appointment you would like to delete.  
   
   You can either delete an appointment occurrence or delete the entire series. To delete the series, click **Go To Series**

2. On the Appointment tab, click the **Delete** icon.

3. On the Delete Confirmation, click **Delete**

### 5.5 Sharing your calendar

You can share your calendar with other people at CSUB. You also can specify how much of your calendar to share.

1. From the Calendar > Home tab, click **Calendar Permissions**

2. In the Calendar Properties box, click **Add User**

3. In the Search box, type the name of the person you want to share your calendar with

4. When you see their name appear in the search results,  
   - Click the name  
   - Click **Add**
5. In the Calendar Properties,
   - In the Permission Level, use the down arrow to assign a level
   - Check the boxes that apply in the Read, Write, Delete and Other sections
   - Click OK

6. To remove permissions from a person, click Remove in the Calendar Properties box

7. Shared calendars appear in the Folder pane of the Calendar module.

5.6 Printing your calendar

You can print your calendar from any view. To print your calendar, follow these instructions.

1. From the Quick Access Toolbar, click the printer icon

2. On the Print screen,
   - Select a printer
   - Under Show Details, make your selections
   - Click Print

The preview shows how your calendar will print.
5.7 Scheduling Meetings

Scheduling meetings is similar to scheduling appointments. The main differences between scheduling meetings and appointments are the additional tasks for inviting participants and scheduling meeting rooms. Additionally, scheduling a meeting will send a meeting request to the selected attendees. Like appointments, you can schedule individual or recurring meetings.

Please note that 25Live is the primary event scheduling application for reserving rooms, such as class rooms, labs, large venues, and some conference rooms. As such, the meeting rooms referred to in this section are ones that are not used by 25Live, such as private conference rooms i.e. ADM 101, etc.

5.7.1 Scheduling Individual Meetings

An individual meeting creates a single entry on your calendar for an event, such as a meeting, conference, etc. These instructions will help you with creating an individual meeting.

1. From the Calendar> Home tab, click Meeting

2. On the Organizer Meeting tab,
   - In the To box, enter the recipient’s name or email address. Use the to search for names
   - In the Subject box, type the subject for your meeting
   - In the Location, type the location for your meeting or use the to search for a room

3. In the Starts,
   - Use the calendar picker to select a date
   - Use the down arrow to select a time

4. In the Ends,
   - Use the calendar picker to select a date
   - Use the down arrow to select a duration

5. In the body, type the meeting information, such as purpose and the agenda.

6. When satisfied, click the Send button.

   A meeting request will be sent to the selected participants.
### 5.7.2 Scheduling Recurring Meetings

A recurring meeting creates multiple entries on your calendar for a single event, such as monthly department meetings, etc. These instructions will help you with creating a recurring meeting.

1. From the Calendar Home tab, click **Meeting**

2. On the Organizer Meeting tab,
   - In the **To** box, enter the recipients’s name or email address. Use the to **search for names**
   - In the **Subject** box, type the subject for your meeting
   - In the **Location**, type the location for your meeting or use the **search for a room**

3. In the **Starts**,
   - Use the calendar picker to select a date
   - Use the down arrow to select a time

4. In the **Ends**, 
   - Use the calendar picker to select a date
   - Use the down arrow to select a duration

5. In the body, type the meeting information, such as purpose and the agenda.

6. On the Organizer Meeting tab, click **Recurrence**

7. On the drop down, make a selection or click **Custom**

8. If you selected Custom...., On the **Appointment Recurrence**, 
   - Select a recurrence pattern, such as **Monthly (1)**
   - Specify the frequency, such as every 1 month (2), On the **Second (3) Monday (4)**
   - Select the ending date, such as **After (5) 10 occurrences (6)**
   - Click **OK**
9. In the body, type the meeting information, such as purpose and the agenda.

![The purpose of meeting is to discuss weekly status reports.]

10. When satisfied, click the **Send** button.

    **A meeting request will be sent to the selected participants.**

### 5.8 Updating Meetings

You can quickly update your meetings from your calendar or by opening your meetings. These instructions will guide you in opening your meetings for updating.

1. From your Calendar, double-click the meeting you would like to update.

![Department Meeting - Meeting Occurrence]

2. If you open a recurring meeting, you will receive a similar message.

    **You can either update the one meeting occurrence or update the entire series.** Once you make your selection, click **OK**

![Open Recurring Item]

3. When the meeting opens, make the desired changes.

    If you open a recurring meeting, you will receive a message, indicating you are viewing a single occurrence of a series.

    **To edit the series, click the Go to Series button.**

![Department Meeting - Meeting Occurrence]

4. When satisfied, click the **Send Update** button to save your changes and email the updated meeting request to the participants.

![Organizer Meeting]
### 5.9 Canceling Meetings

From your calendar, you can cancel meetings quickly. These instructions will assist you in cancelling a meeting from your calendar.

1. From your Calendar, select the meeting you would like to cancel.

2. From the Organizer Meeting tab, click the **Cancel Meeting** icon.

3. From the drop down, make your selection
   - If you want to cancel the series, click the **Cancel Series**
   - Otherwise, click **Cancel** to cancel the one occurrence.

4. On the Cancel Meeting tab,
   - If desired, you can add a reason for the meeting cancellation.
   - Click **Send Cancellation** to send the cancellation message to your attendees.

5. The meeting disappears.
5.10 Responding to Meeting Requests

Meeting requests will appear in your Outlook Inbox. You can quickly respond to the message from your preview pane. You have several options when responding to meeting requests. You can accept, accept tentatively, and decline. Additionally, you can accept tentatively and propose a new time or decline and propose a new time.

5.10.1 Accepting A Meeting Request

You can accept a meeting request from your preview pane. When responding you will have the choice to make a comment before sending, to send the response immediately, or not to send a response. These instructions will guide you in tentatively accepting a meeting request.

1. From your Inbox select the meeting request you would like to respond to.

2. From the Preview Pane, select Accept

3. From the Accept menu, select the desired option.

4. If you selected, Respond with Comments,
   - Add your comments
   - Click Send

5. After responding, the meeting request will disappear from your Inbox. The meeting will appear on your calendar, showing the date and time of your acceptance.

6. The meeting initiator will receive your response in their Inbox.
5.10.2 Tentatively Accepting a Meeting Request

You can tentatively accept a meeting request from your preview pane. When responding you will have the choice to make a comment before sending, to send the response immediately, or to not send a response. These instructions will guide you in accepting a meeting request.

1. From your Inbox select the meeting request you would like to respond to.

2. From the Preview Pane, select Tentative

3. From the Tentative menu, select the desired option.

4. If you selected, Respond With Comments,
   - Add your comments
   - Click Send

5. After responding, the meeting request will disappear from your Inbox. The meeting will appear on your calendar, showing the date and time of your tentative acceptance.

6. The meeting initiator will receive your response in their Inbox.
5.10.3 Declining a Meeting Request

You can decline a meeting request from your preview pane. When responding, you will have the choice to make a comment before sending, to send the response immediately, or not to send a response. These instructions will guide you in declining a meeting request.

1. From your Inbox select the meeting request you would like to respond to.

2. From the Preview Pane, select Decline

3. From the Decline menu, select the desired option.

4. If you selected, Respond with Comments,
   - Add your comments
   - Click Send

5. When you decline a meeting request, the request disappears from your Inbox and it does not appear on your calendar.

6. The meeting initiator will receive your response in their Inbox.
5.10.4 Proposing a New Time

You can respond to your meeting requests from your preview pane. When responding, you propose a new time, while accepting tentatively or declining. These instructions will guide you in proposing a new time.

1. From your inbox, select the meeting request.

2. In the preview pane, select Propose New Time.

3. From the Propose New Time menu, select the desired option.

4. On next screen,
   - Make your changes
   - Click Propose New Time

5. Next,
   - Add comments, if desired
   - Click Send

6. If you declined the request and proposed a new time, the meeting request will not appear on your calendar. If you accepted tentatively and proposed a new time, the meeting request will appear on your calendar.

7. The meeting initiator will receive your response in their Inbox.
6.0 Email Related Policies

CSU Bakersfield has several policies that relate to email and other sensitive data. The list below are a few of the policies involved with email.

- Email Policy
  http://www.csub.edu/its/about/security/supplemental/email/index.html

- Email Blocking Policy and Procedures
  http://www.csub.edu/its/about/policies/tech/emailblock/index.html

- Confidentiality of Email Policy
  http://www.csub.edu/its/about/policies/tech/emailpolicy/index.html

- Instant Messaging Policy
  http://www.csub.edu/its/about/security/supplemental/instantmessage/

For more information, visit the Information Security website at:
http://www.csub.edu/its/about/security/index.html

7.0 Getting Help

If you are unsure or need assistance, please refer to the resources below:

- Resources on the Web
  Outlook 2016 for Mac
  http://www.csub.edu/training/pgms/outlookm/index.html
  Office 2016 for Mac
  http://www.csub.edu/training/pgms/o2016M/index.html

- For general training questions
  Tammara Sherman, Ed.D.
  Campus Training
  661-654-6919
  tsherman@csub.edu
  www.csub.edu/training/index.html

- For help with computer-related Issues
  Help Desk
  661-654-2307
  helpdesk@csub.edu